
GroupWise 7.0 - Email 
 

 
 
GroupWise 7.0 Main Screen – New Look! Page 1 
  
Default Folders Page 2 
  
Communicating via Email Pages 3 - 5 

Read and Send an Email Message  
Spell Check a Message Before Sending  
Reply, Forward, Delete a Message  
Retrieve a Message from the Trash Folder  
Save and Resume Working on a Draft  
Attach Files  
View or Open Attachments  

  
Address Book Page 6 
  
Contacts Page 7 

  
Groups Page 8 

  
Sent Items Page 9 
  
Options Pages 10 - 11 

Set up a Password  
Adding Signatures to Messages  
Customizing the Navigation Bar  
Customizing the Toolbar  
Organize Email in Folders  
Tabbed Item View  

  
Filtering and Categorizing Messages Page 12 
  
Customizing Headers Page 13 
  
Using Help Page 13 
  
Junk Mail Handling Page 14 
  
WebAccess Pages 15 - 16 
  



 1 

GroupWise 7.0 Main Screen – New Look! 
 
 
 
 
 
 
 

 
 

 
 
 

���������
�	
	�	���

��	�	���

������

��
������

�	��������
 


���������	������
	
���	����

�	�����

���������
�

�����
����	
�����
���	���

	�����

������� 


��	���	�
�
����



 

 2 

Default Folders 
 

 

Mailbox 
� Contains the incoming messages you receive (your “in box”) 

� Double-click on any message to open it (or click once then 
press enter) 

 
Sent Items 

� Stores copies of messages you have sent 

� In the Sent Items folder you can… 
� View status of messages you have sent 
� Resend messages 
� Retract messages (if recipient has not opened) 

 
Calendar - Covered in GroupWise Calendar 

� Click once here to view your calendar 
 
Contacts 

� Lists everyone in your Frequent Contacts Address Book 

� Creates an entry for anyone that you send an email to 

 
Documents 

� We won’t cover this! 
 
Checklist 

� Electronic “to-do” list 
 
Work in Progress 

� Keeps drafts of unsent messages until you are ready to send 
them 

 
Cabinet 

� You can create folders and store messages here (organize 
your messages) 

 
Junk Mail 

� This is not a default folder. We will cover this item later.  
 
Trash 

� Contains items you delete  

� You can retrieve items from the trash can 

� Items 120 days old are automatically purged 
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Communicating via Email 
 
Read an Email Message 

1. Click on the Mailbox to view the list of items you have received. 
2. Double-click the desired message, or highlight the message and press enter. 

 

Send an Email Message 
1. Click the New Mail toolbar button. 
2. Address the message 

� If the recipient is in your GW Address Book, you can type his/her name, 
allowing auto-complete finish the typing.  (Or click on the Address button and 
select the person there.) 

� If the recipient is not in the Address Book, type his/her email address.   
Press Enter to continue adding more recipients.  Press Tab to go to the next 
field if there are no more recipients. 

3. Optional -- Complete the CC: (carbon copy) and BC: (blind copy) fields. 
4. In the subject field, type a brief, meaningful message. 
5. Type your message in the message field. 
6. Click the Send button.  

 

Spell Check a Message Before Sending 
After writing your message, but before sending it, choose Tools / Spell Check.  
NEW!  Your subject line will be checked for spelling errors. 
 

You can automate spell checking to happen every time you send a message by 
choosing Tools / Options / Environment / General tab and selecting “Check spelling 
before send”. 
 

NEW!  Spell Check as You Type 
Use spell checking as you type to check for misspelled or duplicate words, and irregular 
capitalization in items you are creating. When spell checking finds a misspelled word as 
you type, the word is underlined in red (just like the spell checker in Microsoft Word).  
 
Right click on the underlined word to reveal a suggested word list. You may choose to 
correct the spelling of the word, add the word to your word list, always skip the word, or 
disable spell checking as you type.  
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Reply to a Message 
1. While the message is open, click Reply. 
2. Choose either “Reply to sender” or “Reply to all” (i.e., send reply to all recipients 

and to those on the CC: list). 
3. Click OK. 
4. Type your response. You can type it above the original message or intersperse 

comments in the original message.  If you intersperse your reply with the original 
message, choose another font, style, or color to distinguish your remarks. 
 

Forward a Message 
1. Open the message to be forwarded. 
2. Click on the forward button. The forwarded message appears in full text at the 

bottom of the message. 
3. Address the message, and type any comments you want to include. 
4. Click Send. 

 

Delete a Message 
1. Highlight the message in your mailbox. 
2. Press the Delete key.  The message is moved to the GW Trash folder.  

 

Retrieve a Message from the Trash Folder 
1. Click on the Trash folder to open it. 
2. Highlight the message. 
3. Choose Undelete from the Edit menu (or right-click on the message and choose 

Undelete from the pop-up menu).  The message will be restored to its original 
location. 

 

Save a Draft 
1. While working on an email message, go to the File menu and choose Save Draft. 
2. Select the Work in Progress folder and click OK. 

 

Resume Working on a Draft 
1. Click on the Work in Progress folder to view its contents. 
2. Double-click on the message you want to work on. 
3. Finish the message and click Send. 
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Attachments  
 
Attach Files 

1. Start a new message as described above. 
2. Before sending, click on the Attach button. 
3. Navigate through the folders on your computer to select the file you want to attach.   
4. Click OK.  The attached file appears below the message. 

 

View or Open Attachments 
NOTE:  The very first time you open an attachment in GroupWise 7.0, you must 
choose how you want GroupWise to open all attachments:  
 

a. by starting the default application, such as Word (answer Yes),  OR 
b. by opening the GroupWise Viewer (answer No).  

 

You can change this setting later by choosing: 
Tools menu / Options / Environment / Default Actions File Attachments: Open 
Attachment / Open in a New Window 
 

1. Open an email message.   
2. Double-click on an attachment (below the body of the message).  This will either 

open the application used to create the document (ex: Word, Excel), or open the 
GroupWise Viewer (which will allow you to save the document locally or open its 
application). 

3. OR Right-click on the attachment and choose to open it, view it, save it, or print it. 
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Address Book 
 

The Address Book has been reorganized to display Address Books in an Address Book 
List in the left pane of the Address Book window. You can expand and collapse each 
Address Book by clicking +  and  -.  
 
Expand an Address Book to see any Groups. Click on the Address Book or group name 
to display information about contacts, resources, organizations, and groups in the right 
pane of the Address Book window 
 
Sections of the Address Book 

• Novell GroupWise system Address Book -- Lists name, email, phone number, 
etc. of everyone in NCCCS that uses GW.  Only the GW system administrator 
can make changes here. Public groups established by the system office are 
here. 

• Personal Address Books -- You can add contact info for people who are not in 
the system Address Book. You can also create your own personal groups here. 

• Frequent contacts -- GW maintains a list of each person you send an email 
message to. When you start typing a name in the “To:” line, GW searches here 
first. 

 
Contacts Folder  
The Contacts folder represents the Frequent Contacts in your Address Book. Any 
modifications you make in the Contacts folder will also be made in the Frequent 
Contacts Address Book. From this folder, you can view, create, and modify contacts 
and groups.  
 
Comments Tab 
Keep track of notes about a specific contact by writing a comment. Double click the 
contact to open the contact’s info and click on the Comments tab. Insert a Timestamp to 
document the date and time before adding a comment.  
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Contacts 
 
Add a Contact to your Frequent Contacts from an Email that you Receive 

1. Open an email that you received 
2. Right click on name in the From: field 
3. Choose Add to Address Book 
4. Pick the Address Book you want the contact created in 

Note: A contact is automatically created in Frequent Contacts when you send an email.  
 
Manually Add a Contact to your Personal Address Book 

5. Open the Address Book. 
6. Click the Address Book with your name on it to view your personal Address Book. 
7. Click the New button / Choose Contact / Click OK 
8. Fill in the person’s first name, last name, email address, phone number, etc. (You 

can tab between fields.) Record as much or as little info as you like. 
9. Click OK. 

 

Modify an Entry in your Personal Address Book 
1. Open the Address Book and choose your personal Address Book. 
2. Highlight the contact you want to edit. 
3. Click the Details button. 
4. OR Double-click the contact. 
5. Change any information, and then click OK.  
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Groups 
 
Create Groups 
NOTE: Groups may be comprised of addresses from the “master” Address Book, your 

personal Address Book, or both.  If you want to add people to a group who are 
not in the “master” book, you must first add them to your personal Address Book. 

1. Open the Address Book. 
2. Choose the Address Book where you would like to put your group. 
3. Right-click the Address Book in the left pane. 
4. Choose New Group. 
5. Type the name of the group. 
6. Press enter to accept the changes. 

 

Add Names to a Group 
1. Find the Address Book where you created the group. 
2. Click on the group name in the left pane. 
3. Choose any Address Book to find the contact that you want to add to the group. 
4. Drag a name from the right pane to the group in the left pane. 

 

Address a Message to a Group 
1. Start a new email message. 
2. Click the Address icon 
3. Go the Address Book where the Group is saved 
4. Double click on the group name 
5. Click OK. 

 

Modify a Group 
1. Open the Address Book. 
2. Find the group you want to edit. 
3. Right click on the group in the right pane and choose Details. 
4. In the list of group members, highlight a member and Remove.   

Or, add new members. 
5. Click OK to save changes. 
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Sent Items 
 
Note: Most tracking functions apply to messages sent to other GW users.  You cannot 

retract a message sent to a non-GW address or find out whether it was opened. 
 
Another note  
The very first time you double-click on an item in your Sent Items folder, you are asked 
to choose a default method of viewing sent items: 

a. view the item’s Properties, OR 
b. open the item (view the original sent item). 

You can change this setting later by choosing Tools menu / Options / Environment / 
Default Actions. 
 
Check the Status of a Message 

1. Click the Sent Items folder to open it. 
2. Right click on a sent item and choose Properties to display the item’s tracking 

information. 
 
Retract an Unopened Message from the Recipient’s Mailbox 

1. Open the Sent Items folder. 
2. Right click on the unopened message and choose Delete and Empty 
3. Choose All Mailboxes. 
4. Click OK. 

 
Resend a Message 
If you find an error in a message you already sent, and the recipient has not opened it 
yet, here’s how to make the correction and retract the original. 
 

1. Open the Sent Items folder. 
2. Right click the unopened message you want to resend and choose Resend. 
3. Make changes to the message, click the Send button 
4. Click Yes when you are asked if you want to retract the original item. 
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Options 
 

Set a Password 
1. From the Tools menu, choose Options, then double-click Security. 
2. Enter a password in the New Password field. 
3. Type the same password again in the Confirm New Password field.   
4. Choose OK to set the password.   

The next time you log in to GW you will need to type your password. 
Passwords are case sensitive. 

Notes: You will need to set a password in order to use GroupWise WebAccess. 
If you forget your password the GW system administrator can clear it. 

 

Add a Signature to Messages 
1. Go to Tools / Options, double click Environment.  
2. Click the Signature tab. 
3. Select Signature. 
4. Click New. 
5. Type the name of your signature, then click OK. 
6. Use the editor to create your signature. 
7. Select if you want to automatically add your signature or prompt before sending. 
8. Select if you want this to be your default signature. 
9. Click OK, then click Close. 

 
NEW!  Create Multiple Signatures 

1. Click New to create another signature. 
2. Supply a New Signature Name. 
3. Choose the Signature you would like to attach to the bottom of the email by 

choosing from the drop down list.  
Note:  You may also rename or delete signatures. 
 
NEW!  Navigation Bar  
The Navigation Bar allows for quick access to your most used folders. By default, the 
Navigation bar contains shortcuts to your Home view, Mailbox, Calendar, Sent Items, 
and Contacts. However, the Navigation bar is customizable, so you can add the 
shortcuts you use the most to the Navigation bar.  
  
Customize the Navigation bar 

1. Click the Nav Bar Options drop-down arrow > Customize Nav Bar. 
2. Select the folders you want on the Navigation bar, then click OK. 
3. Remove folders by deselecting the folders to be removed. 
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Customize the Toolbar 

1. Right-click on the toolbar and choose Customize Toolbar... and click Show tab.  
2. Choose how you want the toolbar to display.  
3. Click the Customize tab. 
4. Click a category (menu titles) in the list to display a group of toolbar icons.  You 

can click on any icon to see its name and function.  To add a selected button to 
your toolbar, click on Add Button. 

5. To delete an icon from the toolbar, drag it off the toolbar.  You can also rearrange 
toolbar buttons by dragging them around.  

6. To change the order of a button on a toolbar, drag it to where you want it to 
display. 

7. When you are finished, click OK. 

Organize your Email 
You can organize items by moving them from your Mailbox into folders that you create 
in your Cabinet. 
 

To create folders 
1. Click on the Cabinet on the left side of the GroupWise screen.  
2. Choose File / New / Folder. 
3. Click Next to create a personal folder, then give the folder a name.  You can click 

the Up/Down buttons to place the folder where you want it in the Cabinet.   
4. Click Next again. 
5. You will see many options for the folder.  Click Finish to accept the defaults. 
6. Click and drag items from your Mailbox into your folders. 

 
Tabbed Item View 
All Item windows (such as new mail, received messages, appointments, tasks, etc.) now 
use tabs. Click on a tab to make selections and specify additional information about that 
item. 
 
Examples: 
When composing New Mail, the Send Options tab lets you select the send options 
such as Priority, Delayed Delivery, Security, Status Tracking, for that message.  
 
Messages that have been received or sent have a Properties tab shows that allows 
you to see who else received the item, the size and creation date of attached files, and 
more.  
 
The Personalize tab gives you the option of adding a personal subject and assigning a 
category to the item. The original subject of the email displays in the message window, 
your personal subject appears in the details list.
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Filtering and Categorizing Messages 
 
Filters 
Search for messages by using the Filter or Quick Filter from the message list header. 

 
Choose from theses Filter options: 

• From:, To, CC:,  
• Subject: 
• Message, Attachments – NEW! 
• Category – NEW! 
• Filter for Received, Sent, Posted, or Draft Items 

 
NEW!  Quick Filter 
Use the Quick Filter to perform a search in the selected panel or folder. The Quick Filter 
searches on fields such as From, Subject and Date that are available in the selected 
panel or folder. The Quick Filter does not search message bodies or attachments. 
 
Categories  
Use Categories to filter, color code and organize your email. Edit or remove color from a 
category. Rename or delete a category. Assign a category to an email by right-clicking 
on the email and choosing categories. Choose a category from the list. 

 
Default Categories include:  

• Follow-up 
• Low priority  
• Personal 
• Read Later 
• Urgent 
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Customizing Headers 
Headers have been added above the message list, folder fist, calendar, and 
QuickViewer. They have also been added to items such as email and tasks. These 
headers provide information about the folder or view you are in.  
 
Customize Headers 
 
Header Color 

1. Right-click the header that you want to change 
2. Click Header Color 
3. Choose a color and click OK 

 
Header Text Color 

1. Right-click the header 
2. Click Header Text Color 
3. Choose a color and click OK 

 
Header Font Size 

1. Right-click the header 
2. Click Header Font Size 
3. Click a font size 

 

Using Help 
As always, GroupWise has a great Help menu. To access the Help Topics:  

Go to Help / Help Topics 
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Junk Mail Handling 
Use Junk Mail Handling to decide what to do with unwanted email that is sent to 
your GroupWise email address. Junk Mail Handling does not apply to email from a 
sender that is part of your GroupWise system. 

 
Junk Mail Handling allows you to: 

• Modify Junk Mail Handling lists and settings 
• Block or junk email from a user 
• Junk email from users not in a personal Address Book (not 

recommended) 
• Automatically delete items from the Junk Mail folder 

 
To send an email to a Junk Mail list: 
Right-click on the email and choose: 

• Trust sender… 
• Junk sender… 
• Block sender… 
• Choose Junk Mail Handling to change your settings or view contents of a 

list 
 

 

Enable Junk List 
Creates a Junk Mail 
folder in your folder list. 
You control what email 
addresses are on the 
Junk List. 

Automatically move items 
from the Junk Mail folder 
to the Trash. Default is 14 
days. 

Block email from 
addresses that you 
place on the Block List.  
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GroupWise WebAccess – New Look!  
 

• WebAccess address: http://mail.durhamtech.edu:82/ 

• Or from www.durhamtech.edu look under Quick Links 

GroupWise WebAccess now looks more like the client on your office computer. 
GroupWise WebAccess enables you to access your GroupWise mailbox through a Web 
browser when you are away from your office.  With WebAccess you can check your 
mail, send messages, check your calendar -- almost all of the things that you can do 
through GroupWise in your office.   
 
Important notes:  
� You must have access to the Internet to get to WebAccess 
� You must have a password set in order to use WebAccess 

(To set up password:  On your office computer, open GroupWise.  From the Tools 
menu, choose Options.  Double-click on Security.  Enter password 2 times and click 
OK.  Click OK again to exit Options). 

 
Here’s how to check your GroupWise email on the Web: 
 

1. Go to the GroupWise WebAccess address: http://mail.durhamtech.edu:82/ 
 

2. The WebAccess login page appears: 
 
 

 

 
 
 
Login Information 
Username:  Enter your user ID (ex: hortons) 
or your name as it appears in the GroupWise 
Address Book (ex: Susan Horton) 
Password is required 
 
Choose your Connection Speed 
• High (Broadband) - DSL, cable, or the 

Internet from DTCC 
• Low (Dial-up) 
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3. Your mailbox information is displayed: 
 

 

 
 
 
Tips for using GroupWise WebAccess: 
 
• Click any message to view it and read it.  There will be buttons across the top of the 

opened message allowing you to close it, delete it, reply, forward, etc. 

• To compose a new message, just click on the Compose button in the tool bar area.  
Address your message, compose it, and click the “Send” button. 

 

Address Book Tips: 

• When addressing a new message, there is no “auto-complete” feature as in regular 
GroupWise.  You must type the person’s name exactly as it is listed in the 
GroupWise Address Book or type their user ID.  Or, you can click on the Address 
Book button to look up the person. 

• The WebAccess Address Book is a bit different from the regular one.  Use the drop 
down menu boxes to choose options for finding names. For example: the default is: 
last name, begins with. You can type one letter or a few letters of the person’s last 
name to narrow the search. Click the “Search Address Book” button to start the 
search. 

• When you find the person you want in the Address Book, click on the “To” button (or 
the “CC or “BC” buttons) to address the message. Then, click the Mail button to 
begin composing the message. 

 
 


